
Data organization in spreadsheets

Spreadsheets are widely used software tools for data entry, storage, analysis, and

visualization. Focusing on the data entry and storage aspects, this paper offers practical

recommendations for organizing spreadsheet data to reduce errors and ease later

analyses. The basic principles are: be consistent, write dates like YYYY-MM-DD, don't leave

any cells empty, put just one thing in a cell, organize the data as a single rectangle (with

subjects as rows and variables as columns, and with a single header row), create a data

dictionary, don't include calculations in the raw data files, don't use font color or

highlighting as data, choose good names for things, make backups, use data validation to

avoid data entry errors, and save the data in plain text files.
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1 Introduction

Spreadsheets, for all of their mundane rectangularness, have been the subject of angst and

controversy for decades. Some writers have admonished that “real programmers don’t use

spreadsheets” and that we must “stop that subversive spreadsheet” (Casimir 1992; Chad-

wick 2003). Others have advised researchers on how to use spreadsheets to improve their

productivity (Wagner and Keisler 2006). Amid this debate, spreadsheets have continued

to play a significant role in researchers’ workflows, and it is clear that they are a valuable

tool that researchers are unlikely to abandon completely.

The dangers of spreadsheets are real, however – so much so that the European Spread-

sheet Risks Interest Group keeps a public archive of spreadsheet “horror stories” (http:

//www.eusprig.org/horror-stories.htm). Many researchers have examined error rates

in spreadsheets, and Panko (2008) reported that in 13 audits of real-world spreadsheets, an

average of 88% contained errors. Popular spreadsheet programs also make certain types of

errors easy to commit and difficult to rectify. Microsoft Excel converts some gene names to

dates and stores dates differently between operating systems, which can cause problems in

downstream analyses (Zeeberg et al. 2004; Woo 2014). Researchers who use spreadsheets

should be aware of these common errors and design spreadsheets that are tidy, consistent,

and as resistant to mistakes as possible.

Spreadsheets are often used as a multipurpose tool for data entry, storage, analysis, and

visualization. Most spreadsheet programs allow users to perform all of these tasks, however

we believe that spreadsheets are best suited to data entry and storage, and that analysis

and visualization should happen separately. Analyzing and visualizing data in a separate

program, or at least in a separate copy of the data file, reduces the risk of contaminating

or destroying the raw data in the spreadsheet.

Murrell (2013) contrasts data that are formatted for humans to view by eye with data

that are formatted for a computer. He provides an extended example of computer code

to extract data from a set of files with complex arrangements. It is important that data

analysts be able to work with such complex data files. But if the initial arrangement of the

data files is planned with the computer in mind, the later analysis process is simplified.

In this paper we offer practical recommendations for organizing spreadsheet data in a
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way that both humans and computer programs can read. By following this advice, re-

searchers will create spreadsheets that are less error-prone, easier for computers to process,

and easier to share with collaborators and the public. Spreadsheets that adhere to our

recommendations will work well with the tidy tools and reproducible methods described

elsewhere in this collection and will form the basis of a robust and reproducible analytic

workflow.

For an existing dataset whose arrangement could be improved, we recommend against

applying tedious and potentially error-prone hand-editing to revise the arrangement. Rather,

we hope that the reader might apply these principles when designing the layout for future

datasets.

2 Be consistent

The first rule of data organization is be consistent. Whatever you do, do it consistently.

Entering and organizing your data in a consistent way from the start will prevent you and

your collaborators from having to spend time harmonizing the data later.

Use consistent codes for categorical variables. For a categorical variable like the sex of a

mouse in a genetics study, use a single common value for males (e.g. “male”) and a single

common value for females (e.g. “female”). Don’t sometimes write “M”, sometimes “male”,

and sometimes “Male”. Pick one and stick to it.

Use a consistent fixed code for any missing values. We prefer to have every cell filled

in, so that one can distinguish between truly missing values and unintentionally missing

values. R users prefer “NA”. You could also use a hyphen. But stick with a single value

throughout. Definitely don’t use a numeric value like -999 or 999; it is easy to miss that

it is intended to be missing. Also, don’t insert a note in place of the data, explaining why

it is missing. Rather, make a separate column with such notes.

Use consistent variable names. If in one file (for example, the first batch of subjects), you

have a variable called “Glucose 10wk”, then call it exactly that in other files (for example,

for other batches of subjects). If it is variably called “Glucose 10wk”, “gluc 10weeks”,

and “10 week glucose”, then downstream the data analyst will have to work out that

these are all really the same thing.
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Use consistent subject identifiers. If sometimes it is “153” and sometimes “mouse153”

and sometimes “mouse-153F” and sometimes “Mouse153”, there is going to be extra work

to figure out who is who.

Use a consistent data layout in multiple files. If your data are in multiple files and you

use different layouts in different files, it will be extra work for the analyst to combine the

files into one dataset for analysis. With a consistent structure, it will be easy to automate

this process.

Use consistent file names. Have some system for naming files. If one file is called

“Serum batch1 2015-01-30.csv”, then don’t call the file for the next batch “batch2 serum 52915.csv”

but rather use “Serum batch2 2015-05-29.csv”. Keeping a consistent file naming scheme

will help ensure that your files remain well organized, and it will make it easier to batch

process the files if you need to.

Use a consistent format for all dates, preferably with the standard format YYYY-MM-DD,

for example 2015-08-01. If sometimes you write 8/1/2015 and sometimes 8-1-15, it will

be more difficult to use the dates in analyses or data visualizations.

Use consistent phrases in your notes. If you have a separate column of notes (for

example, “dead” or “lo off curve”), be consistent in what you write. Don’t sometimes

write “dead” and sometimes “Dead”, or sometimes “lo off curve” and sometimes “off

curve lo”.

Be careful about extra spaces within cells. A blank cell is different than a cell that

contains a single space. And “male” is different from “ male ” (that is, with spaces at the

beginning and end).

3 Choose good names for things

It is important to pick good names for things. This can be hard, and so it is worth putting

some time and thought into it.

As a general rule, don’t use spaces, either in variable names or file names. They make

programming harder: the analyst will need to surround everything in double quotes, like

"glucose 6 weeks", rather than just writing glucose 6 weeks. Where you might use

spaces, use underscores or perhaps hyphens. But don’t use a mixture of underscores and
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Table 1: Examples of good and bad variable names.

good name good alternative avoid

Max temp C MaxTemp Maximum Temp (◦C)

Precipitation mm Precipitation precmm

Mean year growth MeanYearGrowth Mean growth/year

sex sex M/F

weight weight w.

cell type CellType Cell type

Observation 01 first observation 1st Obs.

hyphens; pick one and be consistent.

Be careful about extraneous spaces at the beginning or end of a variable name. “glucose”

is different from “glucose ” (with an extra space at the end).

Avoid special characters, except for underscores and hyphens. Other symbols ($, @, %,

#, &, *, (, ), !, /, etc.) often have special meaning in programming languages, and so they

can be harder to handle. They are also a bit harder to type.

The main principle in choosing names, whether for variables or for file names, is short,

but meaningful. So not too short. The Data Carpentry lesson on using spreadsheets (see

http://www.datacarpentry.org/spreadsheet-ecology-lesson/02-common-mistakes)

has a nice table with good and bad example variable names, reproduced in Table 1. We

agree with all of this, though we would maybe cut down on some of the capitalization. So

maybe max temp, precipitation, and mean year growth.

Finally, never include “final” in a file name. You will invariably end up with “final ver2”.

(We can’t say that without referring to the widely-cited PhD comic, http://bit.ly/

phdcom_final.)

5

PeerJ Preprints | https://doi.org/10.7287/peerj.preprints.3183v2 | CC BY 4.0 Open Access | rec: 11 Sep 2018, publ: 11 Sep 2018

http://www.datacarpentry.org/spreadsheet-ecology-lesson/02-common-mistakes
http://bit.ly/phdcom_final
http://bit.ly/phdcom_final


4 Write dates as YYYY-MM-DD

When entering dates, we strongly recommend using the global “ISO 8601” standard,

YYYY-MM-DD, such as 2013-02-27. (See the related xkcd comic, https://xkcd.com/1179.)

Microsoft Excel’s treatment of dates can cause problems in data (see https://storify.

com/kara_woo/excel-date-system-fiasco). It stores them internally as a number, with

different conventions on Windows and Macs. So, you may need to manually check the

integrity of your data when they come out of Excel.

Excel also has a tendency to turn other things into dates. For example, some gene

symbols (for example “Oct-4”) may be interpreted as dates and reformatted. Ziemann et

al. (2016) studied gene lists contained within the supplementary files from 18 journals for

the years 2005-2015, and found that ˜20% of the lists had errors in the gene names, related

to the conversion of gene symbols to dates or floating-point numbers.

We often prefer to use a plain text format for columns in an Excel worksheet that are

going to contain dates, so that it doesn’t do anything to them. To do this:

• Select the column

• In the menu bar, select Format → Cells

• Choose “Text” on the left

However, if you do this on columns that already contain dates, Excel will convert them

to a text value of their underlying numeric representation.

Another way to force Excel to treat dates as text is to begin the date with an apostrophe,

like this: '2014-06-14 (see http://bit.ly/twitter_apos). Excel will treat the cells as

text, but the apostrophe will not appear when you view the spreadsheet or export it to

other formats. This is a handy trick, but it requires impeccable diligence and consistency.

Alternatively, you could create three separate columns with year, month, and day. Those

will be ordinary numbers, and so Excel won’t mess them up. Finally, you could represent

dates as an 8-digit integer of the form YYYYMMDD, for example 20140614 for 2014-06-14

(see Briney 2017).

Figure 1 displays a portion of a spreadsheet that we got from a collaborator. We don’t

quite remember what those e’s were for, but in any case having different date formats within
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38.61/11/20068

46.11/11/20067

52.9e6

45.7e5

47e12/6/20054

45.312/9/053

54.912/9/052

WeightAssay dateDate1

CBA

Figure 1: A spreadsheet with inconsistent date formats. This spreadsheet does not adhere

to our recommendations for consistency of date format.

a column makes it more difficult to use the dates in later analyses or data visualizations.

Use care about dates, and be consistent.

5 No empty cells

Fill in all cells. Use some common code for missing data. Not everyone agrees with us on

this point (for example, White et al. (2013) state a preference for leaving cells blank), but

we would prefer to have “NA” or even a hyphen in the cells with missing data, to make it

clear that the data are known to be missing rather than unintentionally left blank.

Figure 2 contains two examples of spreadsheets with some empty cells. In Figure 2A,

cells were left blank when a single value was meant to be repeated multiple times. Please

don’t do this! It is additional work for the analyst to determine the implicit values for

these cells. Moreover, if the rows are sorted at some point there may be no way to recover
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169.41078

149.02015−06−201067

108.01056

117.01045

97.52015−06−181034

95.31023

149.32015−06−141012

glucosedateid1

CBA

A

447412611514172178240246B4

474451354334179166139147A3

mutantnormalmutantnormalstrain2

5 min1 min1

IHGFEDCBA

B

Figure 2: Examples of spreadsheets that violate the ’no empty cells’ recommendation. A: A

spreadsheet where only the first of several repeated values was included. B: A spreadsheet

with a complicated layout and some implicit column headers. For a tidy version of this

data, see Figure 3.

the dates that belong in the empty cells.

The spreadsheet in Figure 2B has a complex layout with information for different treat-

ments. It is perhaps clear that columns B-E all concern the “1 min” treatment, and

columns F-I all concern “5 min”, and that columns B, C, F, and G all concern “normal”,

while columns D, E, H, and I concern “mutant”. But while it may be easy to see by eye,

it can be hard to deal with this in later analyses.

You could fill in some of those cells, to make it more clear. Alternatively, make a

“tidy” version of the data (Wickham 2014), with each row being one replicate and with the

response values all in one column, as in Figure 3. We will discuss this further in Section 7.

6 Put just one thing in a cell

The cells in your spreadsheet should each contain one piece of data. Don’t put more than

one thing in a cell.

For example, you might have a column with “plate position” as “plate-well”, such

as “13-A01”. It would be better to separate this into “plate” and “well” columns (con-

taining “13” and “A01”), or even “plate”, “well row”, and “well column” (containing

“13”, “A”, and “1”). Or you might be tempted to include units, such as “45 g”. It is better
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44725mutantB17

41215mutantB16

47425mutantA15

45115mutantA14

61125normalB13

51415normalB12

35425normalA11

33415normalA10

17221mutantB9

17811mutantB8

17921mutantA7

16611mutantA6

24021normalB5

24611normalB4

13921normalA3

14711normalA2

responsereplicatemingenotypestrain1

EDCBA

Figure 3: A tidy version of the data in Figure 2B.
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215.70.73105.2Male1056

142.41.1683.1Male1045

297.61.23124.8Male1034

243.61.18120.0Female1023

273.40.60134.1Male1012

triglycinsulinglucosesexid1

EDCBA

Figure 4: An example spreadsheet with a rectangular layout. This layout will aid future

analyses.

to write 45 and put the units in the column name, such as body weight g. It is even better

to leave the column as body weight and put the units in a separate data dictionary (see

Section 8). Another common situation is to include a note within a cell, with the data,

like “0 (below threshold)”. Instead, write “0” and include a separate column with such

notes.

Finally, don’t merge cells. It might look pretty, but you end up breaking the rule of no

empty cells.

7 Make it a rectangle

The best layout for your data within a spreadsheet is as a single big rectangle with rows

corresponding to subjects and columns corresponding to variables. The first row should

contain variable names, and please don’t use more than one row for the variable names.

An example of a rectangular layout is shown in Figure 4.

Some datasets won’t fit nicely into a single rectangle, but they will usually fit into a

set of rectangles, in which case you can make a set of Excel files, each with a rectangle of

data. It is best to keep each rectangle in its own file; tables scattered around a worksheet
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are difficult to work with, and they make it hard to export the data to CSV files. You

might also consider having a single Excel file with multiple worksheets. We prefer to have

multiple files with one sheet each so we can more easily save the data as CSV files, but if

you do use multiple worksheets in a file be sure to use a consistent structure.

Some data don’t even fit into a set of rectangles, but then maybe spreadsheets are not

the best format for them, as spreadsheets are inherently rectangular.

The data files that we receive are usually not in rectangular form. More often, there

seem to be bits of data sprinkled about. Several examples are shown in Figure 5. In the

spreadsheets in Figure 5A and 5B, the data analyst will need to study the layout, work

out what everything means, and then spend some time rearranging things. If, from the

start, the data were organized as a rectangle, it would save the analyst a great deal of time.

The example in Figure 5C was based on a dataset that had a separate worksheet for each

subject, each in that complicated format. If all of the worksheets have exactly the same

layout, then it is not too hard to pull out the relevant information and combine it into a

rectangle. (One might write a script in R, Python, or Ruby.) But it is preferable to not

have means and SDs and fold change calculations cluttering up the raw data values, and it

seems that even for data entry, it would be easier to have all of the measurements on one

worksheet. Sometimes it is hard to see how to reorganize things as a rectangle, as in the

example in Figure 5D. It is sort of a rectangle; we could fill in the empty cells in the first

two columns by repeating the individual, date, and weight values. But it seems wrong to

repeat the weights, since they are not repeated measurements.

It is perhaps better to make two separate tables, one with the weights, and one with

these other measurements (which are for an in vivo assay, the glucose tolerance test: give

a mouse some glucose and measure serum glucose and insulin levels at different times

afterwards). An example of this is shown in Figure 6. Note that we’ve also changed the

handling of the “lo off curve” and “off curve lo” notes that were within the insulin

column, by inserting “NA” and adding a “note” column (and being consistent in the text

used in the note). We also added a column name for the first column with subject identifiers.

The layouts in Figure 6A and 6B are examples of “tidy” data (Wickham 2014): each

row is an experimental unit, which is usually just a subject but in the case of Figure 6B is
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0.731.161.231.180.60insulin9

1051041031021018

7

105.283.1124.8120.0134.1glucose6

1051041031021015

4

MaleMaleMaleFemaleMalesex3

1051041031021012

1

FEDCBA

A

446.5447.4412.1597.9610.6514.4BTBR9

423.8474.4450.6408.8353.6333.6B68

MutantNormal7

5MIN6

5

188.1171.6177.8243.1240245.7BTBR4

186.9179.3166155.6138.6146.6B63

MutantNormal2

1MIN1

GFEDCBA

B

2.1720.8323.2419.0520.19treatment B13

6.657.644.643.0215.26treatment A12

SDmeanvaluesfold change11

10

1.0510.1211.2969.2599.811treatment B9

3.233.712.2541.4687.414treatment A8

0.520.491.0810.1910.186control7

SDmeanvaluesexperiment6

fsex5

43Mouse #4

126Days on diet3

11/3/14Date2

1

GFEDCBA

C

off curve lo530.6515

0.151198.5024.72/9/1532314

0.523260.712013

0.5232.76012

0.775362.33011

2.0784391510

2.228297.459

0.251185.8018.92/9/153228

lo off curve217.91207

0.12299.9606

0.175312305

0.129286.1154

0.205349.353

lo off curve99.2024.52/9/153212

insulin ng/mlglucose mg/dltimeGTT weightGTT date1

FEDCBA

D

Figure 5: Examples of spreadsheets with non-rectangular layouts. These layouts are likely

to cause problems in analysis.
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24.72/9/153234

18.92/9/153223

24.52/9/153212

GTT weightGTT dateid1

CBA

A

insulin below curveNA530.6532315

0.151198.5032314

0.523260.712032213

0.5232.76032212

0.775362.33032211

2.0784391532210

2.228297.453229

0.251185.803228

insulin below curveNA217.91203217

0.12299.9603216

0.175312303215

0.129286.1153214

0.205349.353213

insulin below curveNA99.203212

noteinsulin ng/mlglucose mg/dlGTT timeid1

EDCBA

B

Figure 6: Reorganization of Figure 5D as a pair of rectangles.

a single assay measurement on a subject. Reorganizing the data into a “tidy” format can

simplify later analysis. But the rectangular aspect is the most important part.

Another issue we often see is the use of two rows of header names, as in Figure 7. In

this sort of situation, we often see merged cells: merging the “week 4” cell with the two

cells following, so that the text is centered above the three columns with “date”, “weight”,

and “glucose”. We would prefer to have the week information within the variable name.

So, for example, there could be a single header row containing Mouse ID, SEX, date 4,

weight 4, glucose 4, date 6, weight 6, etc. Alternatively, make it a “tidy” dataset with

each row being a subject on a particular day, as shown in Figure 8.

Have sympathy for your analyst (which could be yourself): organize your data as a

rectangle (or, if necessary, as a set of rectangles).

8 Create a data dictionary

It is helpful to have a separate file that explains what all of the variables are. It is helpful if

this is laid out in rectangular form, so that the data analyst can make use of it in analyses.

Such a “data dictionary” might contain:
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44643.62/2/2007556.936.61/19/2007220.219.81/5/2007F34997

182.556.72/2/2007191.342.91/19/200712127.51/5/2007M34496

409.856.212/22/200637845.912/6/2006238.926.611/22/2006F34345

458.757.211/3/2006384.745.110/19/2006202.425.910/6/2006M30174

530.239.64/27/2007460.7314/11/200763519.33/30/2007M30053

glucoseweightdateglucoseweightdateglucoseweightdateSEXMouse ID2

week 8week 6week 41

KJIHGFEDCBA

Figure 7: A spreadsheet with two header rows. It is better to have a single header row.

See Figure 8 for a tidy data layout that eliminates the need for multiple header rows and

repeated column headers.

• The exact variable name as in the data file

• A version of the variable name that might be used in data visualizations

• A longer explanation of what the variable means

• The measurement units

• Expected minimum and maximum values

This is part of the metadata that you will want to prepare: information about the data.

You will also want a ReadMe file that includes an overview of the project and data.

An example data dictionary is displayed in Figure 9. Note that this is a rectangular

dataset, like any other. The first column contains the variable names. The second column is

a more readable version, as might be used in data visualizations. The third column groups

the variables into different categories, which might also be used in data visualizations. The

last column is a description.

Lots of other information could be included. For example, information about the allowed

values for the variables would be helpful in identifying data entry errors.
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44643.62/2/20078F349916

556.936.61/19/20076F349915

220.219.81/5/20074F349914

182.556.72/2/20078M344913

191.342.91/19/20076M344912

12127.51/5/20074M344911

409.856.212/22/20068F343410

37845.912/6/20066F34349

238.926.611/22/20064F34348

458.757.211/3/20068M30177

384.745.110/19/20066M30176

202.425.910/6/20064M30175

530.239.64/27/20078M30054

460.7314/11/20076M30053

63519.33/30/20074M30052

weightglucosedateweeksexmouse_id1

FEDCBA

Figure 8: A tidy version of the data in Figure 7.
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Number of days on high−fat dietclinicalDays on dietdiet_days8

Indicates if mouse stored food in their beddingclinicalCrumblerscrumblers7

Coat color, by visual inspectiondemographicCoat colorcoat_color6

Indicates if mouse showed partial pancreatic inflationclinicalPartial inflationpartial_inflation5

Date mouse was sacrificeddemographicDate of sacsac_date4

Male (M) or Female (F)demographicSexsex3

Animal identifierdemographicMousemouse2

descriptiongroupplot_namename1

DCBA

Figure 9: An example data dictionary.

9 No calculations in the raw data files

Often, the Excel files that our collaborators send us include all kinds of calculations and

graphs. We feel strongly that your primary data file should contain just the data and

nothing else: no calculations, no graphs.

If you are doing calculations in your data file, that likely means you are regularly opening

it and typing into it. Doing so incurs some risk that you will accidentally type junk into

your data.

(Has this happened to you? You open an Excel file and start typing and nothing

happens, and then you select a cell and you can start typing. Where did all of that initial

text go? Well, sometimes it got entered into some random cell, to be discovered later during

data analysis.)

Your primary data file should be a pristine store of data. Write-protect it, back it up,

and don’t touch it.

If you want to do some analyses in Excel, make a copy of the file and do your calculations

and graphs in the copy.
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169.42015−06−201078

149.02015−06−201067

108.02015−06−181056

1.12015−06−181045

97.52015−06−181034

95.32015−06−141023

149.32015−06−141012

glucosedateid1

CBA

A

FALSE169.42015−06−201078

FALSE149.02015−06−201067

FALSE108.02015−06−181056

TRUE1.12015−06−181045

FALSE97.52015−06−181034

FALSE95.32015−06−141023

FALSE149.32015−06−141012

outlierglucosedateid1

DCBA

B

Figure 10: Highlighting in spreadsheets. A: A potential outlier indicated by highlighting

the cell. B: The preferred method for indicating outliers, via an additional column.

10 Don’t use font color or highlighting as data

You might be tempted to highlight particular cells with suspicious data, or rows that

should be ignored. Or the font or font color might have some meaning. Instead, add

another column with an indicator variable (for example, "trusted", with values TRUE or

FALSE).

For example, in Figure 10A, a suspicious entry is highlighted. It would be better to

include an additional column that indicates the outliers (as in Figure 10B). The highlighting

is nice visually, but it is hard to extract that information for use in the later analysis.

Analysis programs can much more readily handle data that are stored in a column than

data encoded in cell highlighting, font, etc. (and in fact this markup will be lost completely

in many programs).

Another possible use of highlighting would be to indicate males and females in a mouse

study by highlighting the corresponding rows in different colors. But rather than use

highlighting to indicate sex, it is better to include a sex column, with values Male or

Female.

11 Make backups

Make regular backups of your data. In multiple locations. And consider using a formal

version control system, like git, though it is not ideal for data files. If you want to get a
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bit fancy, maybe look at dat (https://datproject.org/).

Keep all versions of the data files, so that if something gets corrupted (e.g., you acci-

dentally type over some of the data and don’t notice it until much later), you will be able

to go back and fix it. Before you start inserting more data, make a copy of the file with a

new version number: file v1.xlsx, file v2.xlsx, . . .

When you are not actively entering data, and particularly when you are done entering

data, write-protect the file. That way, you won’t accidentally change things.

• On a Mac, right-click on the file in Finder and select “Get Info”. In the menu

that opens, there is a section at the bottom on “Sharing & Permissions”. Click on

“Privilege” for yourself and select “Read only”.

• In Windows, right-click on the file in Windows Explorer and select “Properties”. In

the “General” tab, there is a section at the bottom with “Attributes”. Select the box

for “Read-only” and click the “OK” button.

Back up your data!

12 Use data validation to avoid errors

Regarding the task of data entry, it is important to ensure that the process is as error-free

and repetitive-stress-injury-free as possible. One useful tool for avoiding data entry errors

is the “data validation” feature in Excel (see http://bit.ly/excel_dataval), to control

the type of data or the values that users can enter into a cell.

• Select a column

• In the menu bar, choose Data → Validation

• Choose appropriate validation criteria. For example

– A whole number in some range

– A decimal number in some range

– A list of possible values

– Text, but with a limit on length
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215.70.73105.2Male1056

142.41.1683.1Male1045

297.61.23124.8Male1034

243.61.18120.0Female1023

273.40.60134.1Male1012

triglycinsulinglucosesexid1

EDCBA

A

id,sex,glucose,insulin,triglyc

101,Male,134.1,0.60,273.4

102,Female,120.0,1.18,243.6

103,Male,124.8,1.23,297.6

104,Male,83.1,1.16,142.4

105,Male,105.2,0.73,215.7

B

Figure 11: A: An example spreadsheet. B: The same data as a plain text file in CSV

format.

At the same time, you could select particular data types for the column, such as text, to

avoid having dates (or transcription factor names!) get mangled by Excel. We mentioned

this before in the discussion of dates, but it is worth repeating:

• Select the column

• In the menu bar, select Format → Cells

• Choose “Text” on the left

This may seem cumbersome, but if it helps you to avoid data entry mistakes, it would

be worth it.

13 Save the data in plain text files

Keep a copy of your data files in a plain text format, with comma or tab delimiters. We

generally use comma-delimited (CSV) files. The spreadsheet in Figure 11A would be saved

as a plain text file with commas separating the fields, as in Figure 11B.

The CSV format is not pretty to look at, but you can open the file in Excel or another

spreadsheet program and view it in the standard way. More importantly, this sort of non-

proprietary file format does not and never will require any sort of special software. And

CSV files are easier to handle in code.

If any of the cells in your data include commas, Excel will put double-quotes around the

contents of each cell when it is saved in CSV format. That requires slightly more finesse

19

PeerJ Preprints | https://doi.org/10.7287/peerj.preprints.3183v2 | CC BY 4.0 Open Access | rec: 11 Sep 2018, publ: 11 Sep 2018



to deal with, but it is generally not a concern.

To save an Excel file as a comma-delimited file:

• From the menu bar, File → Save As

• Next to “Format:”, click the drop-down menu and select “Comma Separated Values

(CSV)”

• Click “Save”

• Excel will say something like, “This workbook contains features that will not work. . . ”.

Ignore that and click “Continue”.

• Quit Excel. It will ask you, “Do you want to save the changes you made?” Click

“Don’t Save”, because you just saved them. (Excel really doesn’t want you to use a

format other than its own.)

Note that there is also an option to save as “Tab Delimited Text”. Many people prefer

that, especially those who work in countries where commas are used a decimal separators.

Also note that, if your Excel file did contain critical features that will not work when

saved as a plain text file, such as highlighted cells, that is a problem; those features will be

lost. For your primary data file, keep things simple.

14 Summary

Spreadsheet programs (such as Microsoft Excel, Google Sheets, and LibreOffice Calc) are

valuable tools for entering, organizing, and storing data. They can also be used for calcu-

lations, analysis, and visualizations, but we have focused on the data organization aspects

here, and we encourage users interested in doing calculations or making data visualizations

within spreadsheets to keep their primary data files pristine and data-only, and to do their

calculations and visualizations in separate files.

We have offered a number of suggestions for how best to organize data within a spread-

sheet. Our primary concerns are to protect the integrity of the data, and to ease later

analysis.

Focus primarily on adopting these principles for future projects. While your current

data files may not meet these standards, it is best not to use copy-and-paste to rearrange
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the files. By doing so, there’s a good chance of introducing errors. Data rearrangement is

best accomplished via code (such as with an R, Python, or Ruby script) so you never lose

the record of what you did to the data.
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